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 Introduction 

Apollo Video Technology’s RoadRunner™ Secure Player (RsPlayer™) provides a secure method of 
playing video clips downloaded from the Roadrunner line of recorders. While the downloaded clips 
have a built-in self-player, RsPlayer enhances the playback experience by adding map and speed 
graph information as well as auxiliary (Accelerometer and Meta) data embedded in the clip. Event and 
Auxiliary data is viewable both in the data panes and with On Screen Display of data synchronized 
with the video. 

RsPlayer utilizes the GPS data embedded in each video clip to display the appropriate map from the 
downloaded clip. The route the vehicle traversed is displayed by a red line and an icon indicating the 
current location. As the clips are played the vehicle locator icon will move across the map synchronous 
with the video. The times displayed on the video playback pane and on the X axis of the graphs is the 
recorder’s local time. 

A Speed Graph shows the speed of the vehicle from the video clip at any point on the route. A cursor 
indicates the current speed and traverses the graph synchronous with video playback. 

Figure 1 - RsPlayer Viewing Windows 

 

 Recommended System Requirements 

Performance may be significantly affected for multi-camera playback containing 360° or 4K 
cameras while in high quality format. Users can improve performance by viewing video clips in 
long-term quality or by viewing cameras in single camera mode. Hardware acceleration 
functionality to improve playback performance will be provided in a future update. 

Figure 2 - System Requirements 

CPU 

(or equivalent) 
RAM 

OS 

 Version 
Storage Graphics Card 

Intel® Core i7  

2.6GHz 
16GB 

Windows® 
7/8.1/10  
64-bit 

Professional 

100GB    
ATI Radeon™ HD 7700 or NVIDIA 
GeForce® GTX650 (1280x1024, 

32bpp), supporting multiple monitors 
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 Using RsPlayer 

 Menu Bar 

The Menu Bar, located at the top of the window, allows a user to open video clips, select active 
windows, change camera layouts and obtain assistance: 

Figure 3 - Menu Bar 

 

File: Open files, Save as a Clip, Print, Print Preview, Print Setup, and/or              
exit the application. 

View: Change the display options including the menus, map, speed graph,           
and event panes. 

Options: Turn on and off the options that will be available when running RsPlayer.  
Activate On Screen Display for Events and Auxiliary Data, Print with or without 
metadata, and Audio Mute Button on/off.  

Layout: Change the desired Camera layout. 

Window: Save or reload a custom layout; reset to default configuration, display frame 
information. 

Help: Displays version information and provides a link to www.apollovideo.com 
where tech tips, updates, and manuals will be posted. 

 View a Clip 

 Double click the RsPlayer icon to start RsPlayer. 

Figure 4 - RsPlayer Icon 

 

 

 

 

 

 

 

 

 

 

http://www.apollovideo.com/
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 Select File, then Open to select the desired video clip file. 

Figure 5 - Open Video Clip File 

 

 Once a video clip has been opened in the RsPlayer format, the video clip can be saved in 
this format to open again automatically in RsPlayer, refer to ection 2.5 Save as a Clip. 

 Video Display Window 

Figure 6 - Video Display Window 
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The video display window shows the cameras as selected by the layout. Standard controls allow 
the user to: 

 Go to the beginning of the recorded video clip 

 Fast reverse 

 Previous frame 

 Play 

 Next frame 

 Fast forward 

 Go to the end of the recorded video clip 

The scroll bar (shown below), allows users to ‘point and click’ and/or drag the indicator to view 
specific video. 

Figure 7 - Scroll Bar 

 

The control bar (shown below), allows users to indicate the fast forward speed through a drop 
down.  Choose the fast forward speed you desire between 2x and 1024x. An Audio Button Mute 
toggle button is also available on the control bar. 

Figure 8 - Control Bar 

 

NOTE: If video decoding is slower than real-time due to performance limitations of the 
user’s machine, a pop-up window notifying a user will be displayed and prevent video 
playback until the user clicks OK. See section 1.1 Recommended System Requirements. 

ALSO NOTE: The pop-up window may be hidden behind RsPlayer or other applications 
that are open. In such cases, an additional tab on the RsPlayer application icon will be 
displayed on the Windows taskbar. To view the pop-up window, hover or click on the 
RsPlayer application icon. 

Figure 9 - Slow Decoding Pop-up Window 
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Figure 10 - Hidden Pop-up Window 

 

 View a Single Camera 

Double-click on any image to view as a single camera. Double-click again to return to multi-
camera view. 

When in single camera view mode, the magnifying glass buttons on the menu bar can be used 
to zoom in and out on the video image. 

Figure 11 - Zoom Controls 

 

 Save as a Clip 

 Click the disk icon on the menu bar. 

 Right-clicking the playback pane will also access a drop-down menu that provides the 
option to “Save as Clip” selection to allow making a self-playing clip from the clip 
being played. Click the disk icon on the menu bar. 

 A menu (Figure 12 - Save as a Clip) allows the user to select the time range and 
number of cameras to be selected and add a password if desired to protect the clip 

 The resulting clip will include all text data and display the map and speed graph 

 Select Start to open a file save dialog box to allow saving the clip with a user defined 

name and location 

Figure 12 - Save as a Clip 
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 Save an Image 

 Right-click the playback pane to access a drop-down menu that provides the option to 
“Save as Image” selection to allow saving the image to a file. 

 A standard Save As file menu will appear. 

 Available image formats will be available. The default is .jpg format or .bmp; .tif is also 
available. 

 Enter a filename then select Save and hit enter to save the image to a file. 

 360° Camera Viewing Options 

Right-click the playback pane on a 360° camera to access a drop-down menu for “Fisheye 
Dewarping” that provides viewing options specific to that 360° camera. 

NOTE: 360° cameras require firmware version 1.5.0 or higher for image dewarping 

functionality. 

Figure 13 - Fisheye Dewarping 

 

Mount Type: Changes the camera orientation to match the mount type used for 
installation (Wall, Ceiling, Desktop). 

Main View: Default 360° camera view with warped image. 

Panoramic: Dewarped and stitched into a single horizontal pane with 360° field 
of view. 

Panoramic 180 * 2: Dewarped and stitched into two horizontal panes with 180° field of 
views each. 

Left-click + Move Left/Right to change camera positioning. 

ePTZ: Single viewing pane with manual control to Pan, Tilt and Zoom. 

Mouse Scroll Up/Down to Zoom In/Out and dewarp the image. 

Left-click + Move Left/Right/Up/Down to change camera positioning. 
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Quad View: Four viewing panes with individual ability to Pan, Tilt and Zoom on 
each (hover over desired pane and use PTZ controls). 

Mouse Scroll Up/Down to Zoom In/Out and dewarp the image. 

Left-click + Move Left/Right/Up/Down to change camera. 

 Combine Audio From Multiple Cameras 

Right-click the playback pane to access a drop-down menu that provides the “Always play audio 
from this camera” option to toggle audio for this camera during multi-camera playback. 

A green dot will be displayed in the bottom-left corner for each camera where audio has been 
enabled. 

Figure 14 - Multiple Camera Audio 

 

 Print, Print Preview and Print Setup 

 From the File menu, the standard print options are available. 

 Print will bring up a print menu. 

 Print Preview will allow you to view the image to be printed with or without metadata 
as well as allow you to zoom in or out prior to printing. To print the image with 
metadata check “Print with Metadata” from Options menu. 

 Print Setup allows you to change printers and printer settings. 

 

 

 

 

 

 

Active audio 

indicator 

Camera audio 

toggle 
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 Data Viewing Panes 

Each Data Viewing Pane (map, event, auxiliary, speed, accelerometer, and metadata depending on 
availability of data in clip) can be un-docked and re-docked. By selecting and dragging the title bar of 
any pane, the pane can be separated from the main video window and displayed on their own, or 
repositioned for a custom view.   

Custom views can be created and recalled using the Window menu. To restore to the default view, 
use the “Reset Window Layout” selection in the Window menu. 

 Map 

The Map Viewing Pane displays the route the vehicle traveled over the duration of the clip as 
well as the current location (in relation to video and speed playback) of the vehicle. 

 The red marker (pip) on the map shows the location of the vehicle and moves synchronous 
with video playback. 

 A user can also ‘point and click’ to drag the pip along the route to update the video to that 
location. 

Figure 15 - Map Pane 

 

 The zoom level of the map can be adjusted using the + and – indicators on the map. 

 The view can be changed from “Map” to “Satellite” by selecting the Map drop-down menu in 
the upper right-hand portion of the pane. 

 Events 

The Event Viewing Pane displays the events as they occur during playback. Any event that is 
configured on the vehicle to display on the Recorder will display in this window. 
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Figure 16 - Event Viewing Pane 

 

 Speed 

The Speed Viewing Pane displays the speed of the vehicle.  

 The circle indicator on the graph indicates the current speed based on the time being 
displayed. 

 “Point and click” on the circle indicator to drag it along the graph to view video at a specific 
speed. 

 The Speed and Accelerometer viewing panes can be docked into tabbed panes by clicking 
and dragging the title bar over the other pane. Click and drag the tab option to un-tab and 
re-dock either pane. 

 Speed is indicated by color on the speed graph. 0 – 25, Green; 25 – 45, blue; 45 – 55, 
orange; and 55 and above, red. 

Figure 17 - Speed Graph 

 

 Accelerometer 

The Accelerometer Graph Viewing Pane displays X, Y and Z Accelerometer values recorded in 
the clip. This graph will only display if there is accelerometer data in the clip. 

Figure 18 - Accelerometer Graph 

 

 Auxiliary Data 

The Auxiliary Data Viewing Pane displays metadata recorded in the clip. This graph will only 
display if there is metadata in the clip. The data labels will display on the left and the data will 
update as the video is played. 
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NOTE: The visibility of the optional Auxiliary Graph Window can be toggled from the 
Auxiliary Graph item in the Window menu on the main viewing window. 

Figure 19 - Auxiliary Data Viewing Pane 

 

Figure 20 - Auxiliary Graphs 
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3.5.1 Strip Charts 

If available, RsPlayer graphs the following data into strip charts: Wheel Speed, Dynamic 
Brake, Air Brake (BC Pressure and BP Pressure), Current (Load), Throttle and Reverser. 
Each of these graphs display a cursor which moves synchronized with video playback. 

Figure 21 - Wheel Speed Strip Graph 

 

3.5.2 Boolean Strip Charts 

If available, RsPlayer graphs the following Boolean values into Boolean strip charts: Horn 
(Horn On, Low Horn On), Bell On, PCS_Open, Engineer Initiated Emergency and 
Trainline Emergency.  Each of these graphs displays a cursor which moves synchronized 
with video playback. 

Figure 22 - Horn Boolean Strip Graph 

 

 

 

 

 

 

 

 

 

 
Please contact technical support at: 888-AVT-USA1 (425-483-7100) or   
email: tech@apollovideo.com for further information or assistance. 
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 End User License Agreement 

FOR SOFTWARE TO BE USED WITH APOLLO VIDEO TECHNOLOGY PRODUCTS 
 
IMPORTANT NOTICE TO END USERS: This End User License Agreement (“Agreement”) is a legal agreement between the 
purchaser (either an individual person or a single legal entity who will be referred to in this Agreement as “You”) of the Licensed 
Software (as defined below) and Apollo Video Technology, LLC (“Apollo”). 
 
BY DOWNLOADING, INSTALLING, COPYING OR OTHERWISE USING THE LICENSED SOFTWARE YOU AGREE TO BE BOUND 
BY THE TERMS OF THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO NOT 
DOWNLOAD, INSTALL, COPY OR USE THE LICENSED SOFTWARE. IF YOU ACQUIRED THE LICENSED SOFTWARE ON 
TANGIBLE MEDIA (e.g. CD) WITHOUT AN OPPORTUNITY TO REVIEW THIS LICENSE AND YOU DO NOT ACCEPT THIS 
AGREEMENT, YOU MAY OBTAIN A REFUND OF THE AMOUNT YOU ORIGINALLY PAID FOR THE LICENSED SOFTWARE IF 
YOU (A) DO NOT USE THE LICENSED SOFTWARE AND (B) RETURN IT, WITH PROOF OF PAYMENT, TO THE LOCATION 
FROM WHICH IT WAS OBTAINED WITHIN THIRTY (30) DAYS OF THE PURCHASE DATE. 
 
This Agreement is effective on the date you manifest your acceptance of this Agreement by downloading, installing, copying or 
otherwise using the Licensed Software. 
 
1. DEFINITIONS. In this Agreement, “Licensed Software” means the computer programs, in machine readable, interpreted, compiled 
or other form, furnished to You for use with Apollo video recorders, whether owned or licensed by Apollo, and including without 
limitation, (a) computer programs residing on any medium and all materials or contained in any download supplied by Apollo in 
connection with the Licensed Software, (b) related explanatory written materials or files ("Documentation")? and (c) upgrades, 
modified versions, updates, additions, and copies of the Licensed Software, if any, provided to You by Apollo, either directly or 
indirectly (collectively, "Updates"). The “Apollo video recorder” means the Apollo mobile digital video recorder products that Apollo 
sold to You, either directly or indirectly. 
 
2. LICENSE. As long as You comply with the terms of this Agreement, Apollo grants You a nonexclusive, nontransferable license to 
use the Licensed Software (in object code form only) for use in the operation of Apollo video recorders. You may make one back up 
copy of the Licensed Software to support your use of the Apollo recorder. 
 
3. SUPPORT SERVICES. Apollo or the reseller or distributor from whom You purchased your Apollo video recorder may provide You 
with support services related to the Licensed Software ("Support Services"). Use of Support Services is governed by the policies and 
programs described in the user manual, in "online" documentation, or in other materials from the support services provider. Any 
supplemental software code provided to You as part of the Support Services are considered part of the Licensed Software and subject 
to the terms and conditions of this Agreement. You acknowledge and agree that Apollo and its licensors, contractors, resellers and 
distributors may use technical information You provide to them as part of the Support Services for their business purposes, including 
for product support and development. 
 
4. RESTRICTIONS. You will not use the Licensed Software in conjunction with any other equipment, system, processing units, or for 
any purpose other than for the operation of the Apollo video recorders and solely for your internal business in accordance with 
operating instructions Apollo or its authorized resellers or distributors may provide from time to time. Unless specifically and expressly 
permitted by Apollo, You agree not to modify, adapt or translate the Licensed Software. You also agree not to reverse engineer, 
decompile, disassemble or otherwise attempt to discover the source code of the Licensed Software or to rent, lease or otherwise 
transfer rights to the Licensed Software. 
 
5. INTELLECTUAL PROPERTY AND CONFIDENTIALITY. The Licensed Software and any copies that You are authorized by Apollo 
to make are the intellectual property of and are owned by Apollo and its licensors. The Licensed Software is protected by U.S. and 
international copyright law. Any copies that You are permitted to make pursuant to this Agreement must contain the same copyright 
and other proprietary notices that appear on or in the Licensed Software. Except for the limited license granted to You herein, all right, 
title and interest reside in Apollo and its licensors. The Licensed Software, including without limitation its structure, organization and 
code, and its accompanying Documentation are Apollo’s or its licensors’ confidential information and constitute trade secrets. 
 
6. LIMITED WARRANTY. Apollo warrants that the Licensed Software will perform substantially in accordance with the accompanying 
materials and online documentation publicized by Apollo for a period of three (3) years from the date of receipt. Any supplements or 
updates to the Licensed Software provided to You after the expiration of the limited warranty period are not covered by any warranty 
or condition, express or implied. Apollo and its licensors and suppliers’ entire liability and your exclusive remedy will be, at Apollo’s 
option, (a) return of the price paid (if any) for the Licensed Software, or (b) repair or replacement of the Licensed Software that does 
not meet this limited warranty and that is returned to Apollo. This Limited Warranty is void if failure of the Licensed Software has 
resulted from accident, abuse, misapplication, abnormal use or a virus. 
 
7. DISCLAIMER OF WARRANTIES. THE LIMITED WARRANTY THAT APPEARS ABOVE IS THE ONLY WARRANTY, EXPRESS 
OR IMPLIED, MADE TO YOU BY APOLLO. EXCEPT FOR THE LIMITED WARRANTY STATED ABOVE, APOLLO PROVIDES THE 
LICENSED SOFTWARE AND SUPPORT SERVICES TO YOU ON AN “AS IS” BASIS AND HEREBY DISCLAIMS ALL OTHER 
WARRANTIES AND CONDITIONS, EITHER EXPRESS, IMPLIED OR STATUTORY, INCLUDING, BUT NOT LIMITED TO, ALL 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR PURPOSE. 
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8. EXCLUSION OF CONSEQUENTIAL AND OTHER DAMAGES. TO THE MAXIMUM EXTENT PERMITTED BY APPLICABLE LAW, 
NEITHER APOLLO NOR ITS LICENSORS WILL BE LIABLE FOR ANY SPECIAL, INCIDENTAL, INDIRECT, OR CONSEQUENTIAL 
DAMAGES WHATSOEVER ARISING OUT OF OR IN ANY WAY RELATED TO YOUR USE OF THE APOLLO VIDEO RECORDER, 
THE LICENSED SOFTWARE, THE PROVISION OF OR FAILURE TO PROVIDE SUPPORT SERVICES, OR OTHERWISE UNDER 
OR IN CONNECTION WITH THIS AGREEMENT EVEN IF APOLLO OR ANY LICENSOR HAS BEEN ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES. 
 
9. LIMITATION OF LIABILITY AND REMEDIES. THE ENTIRE LIABILITY OF APOLLO AND ANY OF ITS LICENSORS UNDER THIS 
AGREEMENT AND YOUR EXCLUSIVE REMEDY (EXCEPT FOR ANY REMEDY OF REPAIR OR REPLACEMENT ELECTED BY 
APOLLO WITH RESPECT TO ANY BREACH OF THE LIMITED WARRANTY) SHALL BE LIMITED TO THE GREATER OF THE 
AMOUNT ACTUALLY PAID BY YOU FOR THE LICENSED SOFTWARE OR U.S. $5.00. THE FOREGOING LIMITATIONS, 
EXCLUSIONS AND DISCLAIMERS (INCLUDING SECTIONS 7, 8 AND 9) SHALL APPLY TO THE MAXIMUM EXTENT PERMITTED 
BY APPLICABLE LAW, EVEN IF ANY REMEDY FAILS ITS ESSENTIAL PURPOSE. 
 
10. TERMINATION. If You breach any provision of this Agreement, then Apollo may terminate any license granted hereunder effective 
immediately without liability after 10 days written notice to You, and You will promptly return to Apollo all copies of the Licensed 
Software. 
 
11. ASSIGNMENT AND TRANSFER. You may not sell, lease, rent, assign, sublicense or transfer the Software except that You may 
transfer all of Your rights under this Agreement as part of a sale or transfer of Apollo video recorder(s). Such a sale or transfer may 
only be made if You retain no copies of the Software, You transfer all of the Software (including any media, archival copies, upgrades 
and Documentation) and the recipient agrees to abide by the terms of this Agreement. An upgrade may not be transferred unless You 
transfer all prior versions of the Software. In the event of any such transfer, You shall remain liable and responsible to Apollo for the 
performance of all of Your duties and obligations under this Agreement. 
 
12. GOVERNMENT LICENSEE. The Apollo video recorder, Licensed Software and the accompanying Documentation were 
developed solely at private expense. All rights of the U.S. government are set forth herein. 
 
13. GOVERNING LAW AND VENUE. This Agreement is governed by the laws of the State of Washington, USA, excluding its choice 
of law rules and the United Nations Convention on Contracts for the International Sale of Goods. Venue and jurisdiction of any claim 
or action involving this Agreement shall exist exclusively in the state and federal courts located in King County, Washington, USA. 
 
14. GENERAL PROVISIONS. This Agreement is the entire agreement between the parties with respect to the subject matter set forth 
herein and supersedes all prior oral written agreements between the parties with respect thereto and may only be amended in writing 
by the parties. If a court of competent jurisdiction finds that any provision of this Agreement is unlawful or unenforceable, then it is the 
intent of the parties that such court applies a rule of reasonableness and modifies the provision in question so that it will remain in 
effect to the greatest extent permitted by law. If a court finds such procedure to be inappropriate, then the provision held unlawful or 
unenforceable shall be severed from this Agreement and the remaining provisions of this Agreement shall remain in full force and 
effect. Sections 4, 5, 7, 8, 9, 13 and 14 (and all provisions of this Agreement which may reasonably be interpreted or construed as 
surviving the expiration or termination of this Agreement) shall survive the expiration or termination of this Agreement. 

 

 
 

 


